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SUMMARY:  23 
We present a detailed protocol to generate a murine xenograft model of venous malformation. 24 
This model is based on the subcutaneous injection of patient-derived endothelial cells containing 25 
hyper-activating TIE2 and/or PIK3CA gene mutations. Xenograft lesions closely recapitulate the 26 
histopathological features of VM patient tissue.  27 
 28 
ABSTRACT:  29 
Venous malformation (VM) is a vascular anomaly that arises from impaired development of the 30 
venous network resulting in dilated and often dysfunctional veins. The purpose of this article is 31 
to carefully describe the establishment of a murine xenograft model that mimics human VM and 32 
is able to reflect patient heterogeneity. Hyper-activating non-inherited (somatic) TEK (TIE2) and 33 
PIK3CA mutations in endothelial cells (EC) have been identified as the main drivers of pathological 34 
vessel enlargement in VM. The following protocol describes the isolation, purification and 35 
expansion of patient-derived EC expressing mutant TIE2 and/or PIK3CA. These EC are injected 36 
subcutaneously into the back of immunodeficient athymic mice to generate ectatic vascular 37 
channels. Lesions generated with TIE2 or PIK3CA-mutant EC are visibly vascularized within 7‒9 38 
days of injection and recapitulate histopathological features of VM patient tissue. This VM 39 
xenograft model provides a reliable platform to investigate the cellular and molecular 40 
mechanisms driving VM formation and expansion. In addition, this model will be instrumental for 41 
translational studies testing the efficacy of novel drug candidates in preventing the abnormal 42 
vessel enlargement seen in human VM.  43 
 44 
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INTRODUCTION: 45 
Defects in the development of the vasculature are the underlying cause of many diseases 46 
including venous malformation (VM). VM is a congenital disease characterized by abnormal 47 
morphogenesis and expansion of veins1. Important studies on VM tissue and endothelial cells 48 
(EC) have identified gain-of-function mutations in two genes: TEK, which encodes the tyrosine 49 
kinase receptor TIE2, and PIK3CA, which encodes the p110α (catalytic subunit) isoform of PI3-50 
kinase (PI3K)2–5. These somatic mutations result in ligand-independent hyper-activation of key 51 
angiogenic/growth signaling pathways, including PI3K/AKT, thereby resulting in dilated ectatic 52 
veins3. Despite these important genetic discoveries, the subsequent cellular and molecular 53 
mechanisms triggering abnormal angiogenesis and the formation of enlarged vascular channels 54 
are still not fully understood.  55 
 56 
During normal and pathological angiogenesis, new vessels sprout from a pre-existing vascular 57 
network and EC undergo a sequence of important cellular processes including proliferation, 58 
migration, extracellular matrix (ECM) remodeling and lumen formation6. Two- and three- 59 
dimensional (2D/3D) in vitro cultures of EC are important tools to investigate each of these 60 
cellular properties individually. Nevertheless, there is a clear demand for a mouse model 61 
recapitulating pathological vessel enlargement within the host microenvironment while 62 
providing an efficient platform for preclinical evaluation of targeted drugs for translational 63 
research.  64 
 65 
Up to date, a transgenic murine model of VM associated with TIE2 gain-of-function mutations 66 
has not been reported. Current transgenic VM mouse models rely on the ubiquitous or tissue-67 
restricted expression of the activating mutation PIK3CA p.H1047R3, 5. These transgenic animals 68 
provide significant insight into whole-body or tissue-specific effects of this hotspot PIK3CA 69 
mutation. The limitation of these models is the formation of a highly pathological vascular 70 
network resulting in early lethality. Thus, these mouse models do not fully reflect the sporadic 71 
occurrence of mutational events and localized nature of VM pathology.  72 
 73 
On the contrary, patient-derived xenograft models are based on the transplantation or injection 74 
of pathological tissue or cells derived from patients into immunodeficient mice7. Xenograft 75 
models are a powerful tool to broaden knowledge about disease development and discovery of 76 
novel therapeutic agents8. In addition, using patient-derived cells allows scientists to recapitulate 77 
mutation heterogeneity to study the spectrum of patient phenotypes.  78 
 79 
Here, we describe a protocol where patient-derived VM EC which express a mutant 80 
constitutively-active form of TIE2 and/or PIK3CA are injected subcutaneously in the back of 81 
athymic nude mice. Injected vascular cells are suspended in an ECM framework in order to 82 
promote angiogenesis as described in previous vascular xenograft models9–11. These VM EC 83 
undergo significant morphogenesis and generate enlarged, perfused pathological vessels in the 84 
absence of supporting cells. The described xenograft model of VM provides an efficient platform 85 
for preclinical evaluation of targeted drugs for their ability to inhibit uncontrolled lumen 86 
expansion.  87 
 88 



   

 
 

PROTOCOL:  89 
Patient tissue samples were obtained from participants after informed consent from the 90 
Collection and Repository of Tissue Samples and Data from Patients with Tumors and Vascular 91 
Anomalies under an approved Institutional Review Board (IRB) per institutional policies at 92 
Cincinnati Children’s Hospital Medical Center (CCHMC), Cancer and Blood Disease Institute and 93 
with approval of the Committee on Clinical Investigation. All animal procedures described below 94 
have been reviewed and approved by the CCHMC Institutional Animal Care and Use Committee. 95 
 96 
1. Preparation of materials and stock solutions 97 
 98 
1.1. Preparation of complete endothelial cell growth medium (EGM)  99 
 100 
1.1.1. Supplement endothelial basal medium (EBM) with the following growth factors present in 101 
the kit (see Table of Materials): human Fibroblast Growth Factor-Beta (hFGF-β), vascular 102 
endothelial growth factor (VEGF), Long Arg3 Insulin-Like Growth Factor- I (R3-IGF-I), ascorbic acid, 103 
epidermal growth factor (EGF), gentamycin sulphate and amphotericin-B, and heparin. Add 1% 104 
Penicillin/Streptomycin/L-Glutamine (PSG) solution and 20% fetal bovine serum (FBS). 105 
 106 
NOTE: We do not recommend adding hydrocortisone. 107 
 108 
1.1.2. Sterile filter the solution under a laminar flow hood through a 0.2 µm bottle top filter into 109 
an autoclaved glass bottle and aliquot media into 50 mL conical tubes and store at 4 °C up to a 110 
week or at -20 °C for up to one year.  111 
 112 
1.2. Prepare collagenase A stock solution 113 
 114 
1.2.1. Prepare 50 mg/mL collagenase A stock solution in 1x phosphate buffer saline (PBS). 115 
 116 
1.2.2. Sterile filter the solution under a laminar flow hood with 0.2 µm filter and syringe, and 117 
store 100 µL aliquots at -20 °C.  118 
 119 
1.3. Prepare tissue collection medium (Buffer A)  120 
 121 
1.3.1. Prepare a Ca2+/Mg2+ stock solution by adding 0.927 g of calcium chloride dihydrate 122 
(CaCl2.2H2O) and 1 g of magnesium sulfate heptahydrate (MgSO4.7H2O) to 500 mL of distilled 123 
water. Sterile filter the solution through a 0.2 µm bottle top filter into an autoclaved glass bottle 124 
and store at room temperature (RT).  125 
 126 
1.3.2. Supplement Dulbecco's Modified Eagle Medium (DMEM) with 10% Ca2+/Mg2+ solution and 127 
2% FBS.  128 
 129 
1.3.3. Sterile filter the solution under a laminar flow hood with 0.2 µm filter and syringe and store 130 
aliquots of 5 mL at -20 °C.  131 
 132 



   

 
 

1.4. Fibronectin coating of tissue culture plates 133 
 134 
1.4.1. Prepare coating buffer (Buffer B) by dissolving 5.3 g of sodium carbonate (Na2CO3; 0.1 M) 135 
in 500 mL of deionized water. Adjust the pH of the buffer to 9.4 using 1 M hydrochloric acid (HCl). 136 
Filter under a laminar flow hood through a 0.2 µm bottle top filter into an autoclaved glass bottle 137 
and store at RT.  138 
 139 
1.4.2. For coating, pipette 2 mL/5 mL/10 mL of Buffer B per 60 mm/100 mm/145 mm tissue 140 
culture plate, respectively. Add 1 µg/cm2 of human plasma fibronectin purified protein solution 141 
and gently distribute the liquid onto the plate. 142 
 143 
1.4.3. Incubate plate at 37 °C, 5% CO2 for 20 min.  144 
 145 
1.4.4. Aspirate Buffer B and wash the plate with PBS prior to culturing cells. 146 
 147 
2. Isolation of endothelial cells from VM patient tissue 148 
 149 
2.1. Isolation of EC from solid VM tissue  150 
 151 
NOTE: VM tissue is resected by debulking surgery12, 13 under an IRB approved protocol. 152 
 153 
2.1.1. Wash VM tissue (tissue sample weight typically ranges between 0.5 g and 1.5 g) in 5% PSG 154 
in PBS.  155 
 156 
2.1.2. Transfer tissue to a 100 mm cell culture dish, mince tissue sample into small pieces using 157 
sterile surgical dissection tools, and transfer into a 50 mL conical tube.  158 
 159 
2.1.3. Add 100 µL of collagenase A stock solution to 5 mL of Buffer A for a final concentration of 160 
1 mg/mL, then add this to the tissue and digest the minced tissue at 37 °C for 30 min while shaking 161 
contents every 5 min.  162 
 163 
2.1.4. Carefully grind the digested tissue at RT using a 6 mm, smooth-surface pestle grinder 164 
within the 50 mL conical tube. 165 
 166 
2.1.5. Continue to carefully grind digested tissue using a pestle while adding 5 mL of cold PBS 167 
supplemented with 0.5% bovine serum albumin (BSA) and 2% PSG. Repeat this step four times. 168 
 169 
2.1.6. Filter the solution through a 100 μm cell strainer into a 50 mL conical tube to remove tissue 170 
fragments.  171 
 172 
2.1.7. Centrifuge cell suspension for 5 min at 400 x g at RT. Proceed to step 2.3. 173 
 174 
2.2. Isolation of VM EC from lesional blood obtained from patient sclerotherapy 175 
 176 



   

 
 

2.2.1. Obtain human VM lesional blood from sclerotherapy under an IRB approved protocol. 177 
 178 
2.2.2. Dilute lesional blood (sample volume typically ranges between 0.5 mL and 5 mL) in PBS to 179 
a final volume of 40 mL. 180 
 181 
2.2.3. Centrifuge cell suspension for 5 min at 200 x g at RT.  182 
 183 
2.3. Initial cell plating  184 
 185 
2.3.1. Discard supernatant and resuspend the single-cell pellet in 1 mL of EGM.  186 
 187 
2.3.2. Add 9 mL of complete EGM onto fibronectin-coated (1 µg/cm²) 100 mm plates and seed 1 188 
mL of cell suspension.  189 
 190 
2.3.3. Incubate cells at 37 °C in a humidified 5% CO2 atmosphere. 191 
 192 
2.3.4. Every other day remove 2 mL of media and add 2 mL of sterile filtered FBS.  193 
 194 
2.3.5. Once cell cultures reach a confluency of 40‒50% change the medium to complete EGM. It 195 
typically takes between 2‒3 weeks for the cells to reach this confluency.  196 
 197 
2.3.6. Observe daily for the appearance of EC colonies. They can be recognized by their typical 198 
“cobblestone-like” morphology (Figure 1A). Between 3‒5 EC-colonies appear in each sample.  199 
 200 
2.3.7. Change the medium every other day for another 5‒7 days until individual EC colonies start 201 
to touch one another.  202 
 203 
2.4. Manual isolation of individual EC colonies  204 
 205 
2.4.1. To harvest EC colonies, wash the plate with 5 mL of PBS and manually aspirate with a 206 
serological pipette.  207 
 208 
2.4.2. Take the plate to a microscope and circle the locations of multiple EC colonies using a 209 
marking pen both on lid and bottom before returning it to laminar flow hood.  210 
 211 
2.4.3. Detach EC colonies by pipetting 50 µL of 0.05% trypsin-EDTA solution on the marked areas.  212 
 213 
2.4.4. Using a small cell scraper or a pipette tip, gently scrape cells from plate. 214 
 215 
2.4.5. Tilt the plate to the nearest edge, and rinse with 1 mL of EGM to neutralize per marked 216 
area and collect cells. 217 
 218 
2.4.6. Count the number of cells using a hemocytometer or automated cell counter. 219 
 220 



   

 
 

2.4.7. Plate the collected EC colonies at a density of 1 x 104 cells/cm2 onto fibronectin-coated (1 221 
µg/cm²) cell culture dishes containing fresh EGM. The next day, change medium to complete 222 
EGM.  223 
 224 
2.4.8. Change the medium to complete EGM every other day for 2‒3 weeks until cells reach 80% 225 
confluency.  226 
 227 
2.4.9. Trypsinize EC with 2 mL of pre-warmed 0.05% trypsin-EDTA per 100 mm dish at 37 °C for 2 228 
min and neutralize trypsin by adding 4 mL of EGM.  229 
 230 
2.4.10. Collect the cell suspension into one 15 mL conical tube and centrifuge at 400 x g at RT for 231 
5 min. Aspirate the supernatant and resuspend cells in 2 mL of EGM.  232 
 233 
2.4.11. Count the number of cells using a hemocytometer or automated cell counter. Typical cell 234 
numbers obtained are 1 x 106 cells per 60 mm cell culture plate or 2 x 106 cells per 100 mm tissue 235 
culture plate.  236 
 237 
2.4.12. Pellet the cells by centrifugation at 400 x g at RT for 5 min and aspirate the supernatant. 238 
Proceed to step 3.2.1. 239 
 240 
3. Endothelial cell selection and expansion 241 
 242 
3.1. Preparation of anti-CD31-conjugated magnetic beads 243 
 244 
3.1.1. Vortex the vial containing the anti-CD31-conjugated magnetic beads for 30 s. The volume 245 
of beads required is 20 µL/2x106 cells. 246 
 247 
3.1.2. Wash 20 µL of anti-CD31-conjugated magnetic beads with 1 mL of wash solution containing 248 
0.1% BSA in PBS in a 1.5 mL microcentrifuge tube.  249 
 250 
3.1.3. Place the microcentrifuge tube in a cell isolation magnet for 1 min.  251 
 252 
3.1.4. Aspirate the supernatant and repeat the washing step.  253 
 254 
3.2. Endothelial cell purification and plating 255 
 256 
3.2.1. Resuspend cell pellet obtained in 2.4.11 in 500 µL of wash solution containing 0.1% BSA in 257 
PBS. 258 
 259 
3.2.2. Add cell solution to microcentrifuge tube containing magnetic beads and resuspend 260 
thoroughly. 261 
 262 
3.2.3. Incubate for 20 min at 4 °C with gentle tilting.  263 
 264 



   

 
 

3.2.4. Add 500 µL of 0.1% BSA in PBS and mix well. 265 
 266 
3.2.5. Place the tube on a cell isolation magnet for 1 min.  267 
 268 
3.2.6. Gently aspirate all of the liquid, which contains the CD31-negative fraction of cells without 269 
touching the beads. 270 
 271 
3.2.7. Wash the bead pellet containing the CD31-positive cell fraction with 1 mL of 0.1% BSA in 272 
PBS and repeat magnetic separation. 273 
  274 
3.2.8. Repeat washing and magnetic separation step for a minimum of 3 times to purify CD31-275 
positive cell fraction.  276 
 277 
3.2.9. Resuspend purified endothelial cells into a 15 mL conical tube and spin down for 5 min at 278 
400 x g at RT. 279 
 280 
3.2.10. Remove supernatant and resuspend cell pellet in 1 mL of EGM.  281 
 282 
3.2.11. Add 9 mL of complete EGM onto fibronectin-coated (1 µg/cm²) 100 mm plates and seed 283 
1 mL of cell suspension. Note that some magnetic beads are still attached to the cells in this initial 284 
seeding step. Most beads wash away during cell expansion, but small number of beads may 285 
persist in early passages.  286 
 287 
3.2.12. Incubate cells at 37 °C in a humidified 5% CO2 atmosphere. 288 
 289 
3.2.13. Change the medium every other day until cells reach 80 % confluency. 290 
 291 
3.3. Endothelial cell expansion 292 
 293 
3.3.1. Once cells reach 80 % confluency, detach with 2 mL of 0.05% trypsin-EDTA per 100 mm 294 
dish at 37 °C for 2 min.  295 
 296 
3.3.2. Neutralize trypsin by adding 4 mL of EGM and collect cells into one 15 mL conical tube. 297 
 298 
3.3.3. Centrifuge at 400 x g at RT for 5 min.  299 
 300 
3.3.4. Aspirate the supernatant, resuspend cells in 2 mL of EGM, and count the number of cells 301 
with a hemocytometer or by automated cell counting.  302 
 303 
3.3.5. Seed cells at a density of 1 x 104 cells/cm² into 145 mm fibronectin-coated (1 µg/cm²) tissue 304 
culture plates.  305 
 306 
3.3.6. Continue to passage cells until the desired cell number has been met. Consider that a 307 
confluent 145 mm tissue culture plate contains about 8‒9 x 106 cells and the number of cells 308 



   

 
 

needed is 2.5 x 106 cells per injection. Only cells between passage 3 and 8 should be considered 309 
for the xenograft.  310 
 311 
4. VM patient-derived xenograft protocol  312 
 313 
NOTE: In this protocol we use 5‒6 week old, male immunodeficient, athymic nude Foxn1nu mice.  314 
All animal procedures must be approved by the Institutional Animal Care and Use Committee 315 
(IACUC). 316 
 317 
4.1. Preparation of materials on the day before injection  318 
 319 
4.1.1. Pre-chill syringes, needles, and pipet tips in -20 °C freezer overnight. 320 
 321 
4.1.2. Slowly thaw the basement membrane extracellular matrix (BMEM) overnight on ice bucket 322 
placed at 4 °C to avoid increased viscosity of the gel. 323 
 324 
4.2. Preparation of cell suspension for injection 325 
 326 
4.2.1. Trypsinize EC with 5 mL of pre-warmed 0.05% trypsin-EDTA per 145 mm dish at 37 °C for 2 327 
min.  328 
 329 
4.2.2. Neutralize trypsin by adding 5 mL of EGM and collect cells into one 15 mL conical tube. 330 
 331 
4.2.3. Centrifuge at 400 x g at RT for 5 min.  332 
 333 
4.2.4. Aspirate the supernatant, resuspend cells in 3 mL of EGM, and count the number of cells 334 
using a hemocytometer or automated cell counter.  335 
 336 
4.2.5. Determine the total number of cells that are needed for all planned injections.  337 
 338 
NOTE: The recommended number of cells is 2.5 x 106 cells per injection. A total of 2 injections 339 
are typically performed in each mouse for technical duplicates. It is necessary to calculate a 10% 340 
excess of cell number to account for loss during transfer into the syringe.  341 
 342 
4.2.6. Transfer the volume containing the calculated cell number into a new 50 mL conical tube 343 
and pellet cells by centrifugation at 400 x g at RT for 5 min.  344 
 345 
4.2.7. Aspirate the supernatant, leaving a small volume (about 50‒70 µL) to loosen the pellet. 346 
 347 
4.3. Syringe preparation  348 
 349 
4.3.1. Calculate an excess volume of 20 µL/injection to account for loss during transfer to the 350 
syringe. Resuspend the cell pellet with 220 µL of BMEM per injection on ice. The injected volume 351 
of cell suspension will be 200 μL per lesion. 352 



   

 
 

 353 
4.3.2. Mix the cell suspension thoroughly on ice to obtain a homogenous cell suspension and 354 
avoid creating bubbles.  355 
 356 
4.3.3. Using a 1 mL pipet and 1 mL syringe, simultaneously pipet BMEM-cell mixture into the 357 
syringe opening by suction force while pulling plunger of syringe.  358 
 359 
4.3.4. Luer lock a 26G x 5/8 inch sterile needle to the syringe and keep prepared syringes flat on 360 
ice prior to injection. 361 
 362 
4.4. Subcutaneous injection into mouse 363 
 364 
4.4.1. Anesthetize the mice with 5% isoflurane/oxygen mixture at a flow rate of 1 L/min using an 365 
isoflurane vaporizer. Ensure proper sedation of animals (e.g., unresponsiveness to toe pinches). 366 
Maintain anaesthesia via continuous administration of 1.5% isoflurane/oxygen delivered via nose 367 
cone. 368 
 369 
4.4.2. Place mice on their stomach, exposing the back region where grafting will occur and 370 
disinfect the injection region with 70% ethanol.  371 
 372 
4.4.3. Gently roll the prepared syringe to resuspend any settled cells. Flick bubbles to the needle 373 
end of the syringe and expel a small volume of the cell suspension to ensure the removal of all 374 
bubbles.  375 
 376 
NOTE: Two injections can be performed for each mouse – on the left and the right side of mouse 377 
back.  378 
  379 
4.4.4. Pinch and create a ‘tent-like’ structure using your thumb and index finger and insert the 380 
needle subcutaneously right under the skin. Ensure that the needle is only skin deep by releasing 381 
pinched skin to prevent injection into muscle tissue.  382 
 383 
4.4.5. Holding needle at 45° angle carefully inject 200 µL of the cell-suspension to create a small 384 
spherical mass (Figure 1C).  385 
 386 
4.4.6. Record mouse weight with a scale, ear tag the mouse, and return to cage.  387 
 388 
4.4.7. Monitor mice following sedation to ensure they return to normal activity. 389 
 390 
4.5. Lesion growth monitoring 391 
 392 
4.5.1. Using a caliper, measure the length and width of each plug (Figure 1D).  393 
 394 
4.5.2. Document measurements every other day up until lesion collection.  395 
 396 



   

 
 

5. Tissue collection and processing  397 
 398 
5.1. Euthanize mice 9 days post-implantation in a CO2 chamber and check vital signs to confirm 399 
death. Perform cervical dislocation on the mice as a secondary method to euthanize the mouse.  400 
 401 
5.2. Harvest the xenograft lesion/plug from the flank of the mouse by dissection using surgical 402 
forceps and scissors.  403 
 404 
NOTE: In order to prevent rupturing the blood-filled vessels within the plug, it is important to 405 
avoid touching the lesion plug with dissection tools and leave excessive surrounding tissue such 406 
as skin attached to the plug.  407 
 408 
5.3. Immerse the resected lesion in PBS to wash. 409 
 410 
5.4. Set up a camera stage with a camera. Align plugs onto a cutting board with a ruler. Take an 411 
image of all plugs to record gross vascularity of lesions (Figure 1E). 412 
 413 
5.5. Fix plugs by submerging in 10% formalin overnight at RT.  414 
 415 
5.6. Wash plugs in PBS the following day and move them into 70% ethanol.  416 
 417 
5.7. Process lesion plugs for paraffin embedding (pathology core).  418 
 419 
6. Lesion sectioning  420 
 421 
6.1. Use a microtome to cut 5 μm sections from the collected murine lesions onto positively 422 
charged slides.  423 
 424 
NOTE: For the subsequent analysis, sections in the center of the plug (about 50‒70 µm into the 425 
tissue) are of importance. 426 
 427 
6.2. Melt paraffin at 60 °C for 1 h prior to staining. 428 
  429 
6.3. De-paraffinize and re-hydrate tissue sequentially under a chemical fume flow hood. 430 
Therefore, incubate slide in xylene for 10 min, 100% ethanol (EtOH) for 5 min, 90% EtOH for 3 431 
min, and 80% EtOH for 3 min.  432 
 433 
6.4. Rinse slide in deionized water for 5 min.  434 
 435 
7. Hematoxylin and Eosin (H&E) 436 
 437 
7.1. Incubate sections in Hematoxylin for 2 min.  438 
 439 



   

 
 

7.2. Place slides in a staining jar and rinse in a sink by a steady stream of tap water until water is 440 
clear. 441 
 442 
7.3. De-hydrate slides by incubating tissue sequentially in 70% EtOH for 1 min, 80% EtOH for 1 443 
min, 90% EtOH for 1 min, 100% EtOH for 1 min, and fresh 100% EtOH for 1 min 444 
 445 
7.4. Stain sections in Eosin Y for 30 s.  446 
 447 
7.5. Rinse in fresh 100% EtOH until solution is clear. 448 
 449 
7.6. Incubate slide in xylenes for 2 min. Let slides dry for 5‒10 min under the fume hood. 450 
 451 
7.7. Dispense a drop of permanent, non-aqueous mounting medium over xenografts sections 452 
and place coverslip on top.  453 
 454 
7.8. Allow slides to dry overnight before imaging.  455 
 456 
8. Immunohistochemistry  457 
 458 
8.1. Prepare antigen retrieval buffer (Tris-EDTA) by weighing 0.6 g of Tris-base and 1 mL of 0.5 M 459 
EDTA to 500 mL of deionized water. Adjust pH to 9.0 using 1 M HCl. Add 250 µL of Tween-20.  460 
 461 
8.2. Incubate de-paraffinized tissue slides (as obtained in step 6.2‒6.3) in a beaker with antigen 462 
retrieval buffer, stirring on a heating block, for 20 min at 95 °C.  463 
 464 
8.3. Remove the beaker from heating block, allow solution to cool to 35 °C then wash in PBS for 465 
3 min. 466 
 467 
8.4. Block tissue sections in 5% normal horse serum in PBS for 30 min at RT.  468 
 469 
8.5. Prepare a biotinylated Ulex europaeus agglutinin-I (UEA-I) working solution by diluting 20 470 
µg/mL of biotinylated UEA-I in 5% normal horse serum in PBS.  471 
 472 
8.6. Pipet 50‒100 µL of UEA-I working solution per section and incubate for 1 h at RT in a 473 
humidifying chamber.  474 
 475 
8.7. Wash slides two times in PBS for 3 min. 476 
 477 
8.8. Quench slide sections in 3% hydrogen peroxide for 5 min at RT. 478 
 479 
8.9. Wash slides two times in PBS for 3 min. 480 
 481 
8.10. Prepare 5 µg/mL of Streptavidin horseradish peroxidase-conjugated in 5% normal horse 482 
serum in PBS.  483 



   

 
 

 484 
8.11. Pipet 50‒100 µL on each tissue slide and incubate for 1 h at RT in a humidifying chamber. 485 
 486 
8.12. Wash slides two times in PBS for 3 min. 487 
 488 
8.13. Prepare 3,3'Diaminobenzidine (DAB) solution according to manufacturer’s instructions and 489 
add 50‒100 µL per section.  490 
 491 
8.14. Incubate sections for 10‒15 min, checking and monitoring for development of stain every 492 
2‒5 min.  493 
 494 
8.15. Wash slides three times in PBS for 3 min. 495 
 496 
8.16. Add a drop of Hematoxylin and incubate for 3 min.  497 
 498 
8.17. Place slides in a staining jar and rinse in a sink by a steady stream of tap water until water 499 
is clear. 500 
 501 
8.18. Sequentially incubate slide in 80% EtOH for 1 min, 90% EtOH for 1 min, 100% EtOH for 1 502 
min, and xylene for 2 min.  503 
 504 
8.19. Let slides dry for 5‒10 min under the fume hood. 505 
 506 
8.20. Dispense a drop of permanent, non-aqueous mounting medium over xenografts sections 507 
and place coverslip on top.  508 
 509 
8.21. Allow slides to dry overnight before imaging. 510 
 511 
9. Analysis of human-derived Vascular Channels  512 
 513 
NOTE: Vascularity of VM lesions is quantified by measuring vascular area and vascular density. 514 
Only UEA-I positive, human-derived vascular channels are considered for quantification.  515 
 516 
9.1. Take four to five images per lesion section with a bright field microscope at a 20x 517 
magnification (high power fields [HPF]). Take HPF images in an x-plane pattern within the lesion 518 
section to avoid overlap (Figure 1F). Include a scale bar on the images taken. 519 
 520 
9.2. Open and the HPF images in Image J (File > Open). Calibrate the pixels of the scale bar as 521 
follows. Use the straight line tool and go over the scale bar. To convert the measured pixels into 522 
mm click on Analyze > Set scale.  523 
 524 
9.3. Click on Analyze > Set Measurements and select Area.  525 
 526 



   

 
 

9.4. Measure the total field area in a HPF using Analyze > Measure. Save this measurement for 527 
quantification in step 9.8.  528 
 529 
9.5. Using the freehand selections tool, manually outline UEA-I+ vascular channels.  530 
 531 
NOTE: A vascular channel is defined as any area that is lined with UEA-I+ - EC that may contain 532 
blood cells.  533 
 534 
9.6. Click on Analyze > Measure to quantify the outlined UEA-I+ vascular area (mm2/HPF). 535 
 536 
9.7. Repeat this measurement for all five HPF taken within one plug.  537 
 538 
9.8. Average the total vascular area of all five HPF (divide by 5). The obtained vascular area per 539 
HPF is subsequently divided by the HPF field area (in mm2, step 9.5) and expressed as a percent 540 
(%). 541 
 542 
9.9. For quantification of vascular density, count the number of UEA-I+ vascular channels of each 543 
HPF taken. The vascular density is the average number of UEA-I+ vascular channels counted per 544 
HPF area (vessels/mm2). 545 
 546 
REPRESENTATIVE RESULTS: 547 
This protocol describes the process of generating a murine xenograft model of VM based on the 548 
subcutaneous injection of patient-derived EC into the back of immunodeficient nude mice. A 549 
scheme summarizing the steps from VM-EC isolation to dissection of lesion plug is presented in 550 
Figure 2. Endothelial cell colonies can be harvested within 4 weeks after initial cell isolation from 551 
VM tissue or lesional blood. The day after injection, the xenograft lesion plug covers a surface 552 
area of approximately 80‒100 mm2. In our hands, lesion plugs with TIE2/PIK3CA-mutant EC are 553 
visibly vascularized and perfused within 7‒9 days from injection 14, 15 (Figure 1C,D). However, the 554 
extent of lesion growth is variable and reflects on patient and sample heterogeneity.  555 
 556 
Lesion plugs closely recapitulate the histopathological features of human VM tissue: enlarged 557 
vascular channels lined by a thin layer of endothelial cells (Figure 1F‒H). These vascular structures 558 
typically contain erythrocytes, confirming functional anastomoses with the host mouse 559 
vasculature (Figure 1F‒H). Immunohistochemical staining using the human specific lectin UEA-I 560 
can confirm that cells lining vascular lesions are derived from human implanted cells rather than 561 
mouse vasculature (Figure 1H).  562 
 563 
FIGURE AND TABLE LEGENDS:  564 
 565 
Figure 1: Representative results. (A) Representative image of primary mixed cell culture three 566 
weeks after isolation from VM tissue before EC selection. Typical endothelial cell colony (EC) and 567 
contaminating fibroblast (FB). (B) Image of a purified (CD31 bead-selection) endothelial cell 568 
culture from VM patient-derived tissue. Scale bar = 200 µm. (C) The lesion will form a spherical 569 
structure. Vascularization is visible due blueish color through the skin of nude mice. (D) Dashed 570 



   

 
 

lines show how lesion size is recoded by measuring the length (L) and the width (W) using a 571 
caliper. (E) Photo of visibly vascularized, xenograft lesion explant at day 9. Scale bar = 1 cm. (F) 572 
Representative image of a lesion plug section. The x-plane pattern in which five high power field 573 
images are taken for quantification are indicated by white dashed boxes. Scale bar = 1000 µm. 574 
(G‒H) Representative images of VM lesion plug sections. (G) Hematoxylin and Eosin staining and 575 
(H) immunohistochemistry of human specific lectin UEA-I. Scale bar = 100 µm. 576 
 577 
Figure 2: Schematic of the workflow to generate a patient-derived xenograft of VM. (A) 578 
Endothelial cells isolated from patient VM lesion solid tissue or lesional blood are plated and, 579 
when 80% confluency is reached, are selected by anti CD31-conjugated immunomagnetic beads 580 
and expanded. (B) For subcutaneous injection of EC, on day 0, skin on the backside of the mouse 581 
is pinched using forefinger and thumb to create a tent-like structure. Lesions are measured at 582 
day 1 and then every other day (red arrows) using a caliper through experimental day 9. Lesions 583 
are dissected and processed for histological analysis.  584 
 585 
DISCUSSION:  586 
Here, we describe a method to generate a patient-derived xenograft model of VM. This murine 587 
model presents an excellent system that allows researchers to gain a deeper understanding of 588 
pathological lumen enlargement and will be instrumental in developing more effective and 589 
targeted therapies for the treatment of VM. This can be easily adapted to investigate other types 590 
of vascular anomalies such as capillary lymphatic venous malformation16. There are several steps 591 
that are crucial for the successful generation of reproducible vascular lesions. First, the patient-592 
derived endothelial cells must be pure (without the presence of other cell types) and growing 593 
exponentially at the time of injection. Contaminating fibroblast or other mesenchymal non-EC 594 
can be easily recognized by elongated morphology as shown in Figure 1A. On rare occasion, it is 595 
possible that even after purification using anti-CD31 antibody conjugated magnetic beads, a 596 
small number of non-EC remain in the culture. These cultures require further purification with 597 
endothelial specific cell surface markers. As an alternative approach, single cell clonal expansion 598 
of endothelial cells is possible. This would reinsure the homogeneity of mutant-EC as all of the 599 
cells within one culture would derive from one single cell. However, this approach is not 600 
recommended for VM-derived EC as cells tend to top their proliferation capabilities and convert 601 
into a senescent phenotype after 9‒10 passages. It is critical to use cells between passages 3‒8 602 
for xenograft experiments and to not passage cells the day before the injection.  603 
 604 
The xenograft model can be modified to investigate other vascular anomalies carrying different 605 
activating mutations. Moreover, as patient tissue samples are difficult to access for some 606 
laboratories, the xenograft model can be adapted by using EC, such as human umbilical cord 607 
blood cells (HUVEC), genetically engineered to express the mutation/s known to cause 608 
dysfunctional vascular growth15, 17. 609 
 610 
The number of cells recommended for the injection in the xenograft is 2.5 x 106 cells/200 µL of 611 
BMEM. However, if the cell number is insufficient it is possible to either reduce the number of 612 
injections per animal to one or to reduce the injection volume to a minimum of 100 µL. For the 613 
latter, it is however important to maintain the cell density ratio e.g., 1.25 x 106 cells/100 µL 614 



   

 
 

BMEM. When working with BMEM, all the steps must be performed on ice to avoid solidification 615 
of the cell suspension before injection. During injection, it is important and that the needle is 616 
inserted at an angle of 45° directly under the skin and away from the muscle tissue, as injecting 617 
into muscle impedes lesion reproducibility and makes the lesion dissection difficult. A total of 618 
two injections can be performed on each mouse—one on the right and one on the left side of 619 
each animal. The second injection in the same mouse can serve as a technical replicate. More 620 
injections on the back are not recommended as lesions grow over time and might interfere with 621 
each other. For statistical analysis in pre-clinical studies comparing xenograft plugs of treated 622 
versus untreated (vehicle only) mice, we recommend the use of a minimum of 5 animals (10 623 
xenograft plugs) per study group. If available, the second injection could alternatively be used as 624 
a ‘internal control’ using non-mutant EC. We have used primary non-mutant EC, such as HUVEC, 625 
as a control and have shown that these cells formed a negligible number of small channels14, 15. 626 
Furthermore, in these HUVEC control lesion plugs, we have noticed infiltration of murine-derived 627 
vascular channels into the plug after day 9. If the experimental design requires longer incubation 628 
times, these infiltrating channels can be easily excluded from analysis by staining for a human-629 
specific marker such as human-specific CD31 antibody or Ulex europaeus agglutinin I (UEA-I) that 630 
does not cross react with mouse. 631 
 632 
To ensure that the lesion does not become a burden to animal health and wellbeing it is 633 
important to observe lesion size, record mouse weight daily, and pay attention to any side 634 
complications such as bleeding and bruising. If the lesion volume exceeds 500 mm3, the 635 
experiment has to be terminated.  636 
 637 
When vascular lesions are enlarged and perfused, extreme attention must be paid during 638 
dissection to avoid rupturing the lesion. It is important to avoid touching the lesion plug with 639 
dissection tools and leave excessive surrounding tissue (such as skin) attached to the plug. This 640 
prevents collapse of the vascular structures within the xenograft plug which would interfere with 641 
accurate analysis.  642 
 643 
Finally, to maintain consistency, it is important that the initial histological analysis begins in the 644 
center of the plug (about 50‒70 µm into the tissue) rather than the border regions where 645 
anastomosing mouse vasculature might be present. It is highly recommended to stain the tissue 646 
sections with a human-specific EC marker, such as UEA-I (Figure 1H) or an alternative human-647 
specific antibody which will not cross-react with mouse, in order to confirm that vascular 648 
structures are formed by human-derived EC rather than invading mouse EC.  649 
 650 
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Name of Material/Equipment

Athymic nude mice, (Foxn1-nu); 5-6 weeks, males

Biotinylated Ulex europeaus Agglutinin-I (UEA-I)

Bottle top filter  (500 ml; 0.2 µM)

Bovine Serum Albumin (BSA) 

Calcium cloride dihydrate (CaCl2.2H2O)

Caliper

CD31-conjugated magnetic beads (Dynabeads) 

Cell strainer (100 μM) 

Collagenase A 

Conical Tube; polypropylene (15 mL) 

Conical Tube; polypropylene (50 mL) 

Coplin staining jar

Coverglass (50 X 22 mm) 

DAB: 3,3'Diaminobenzidine Reagent (ImmPACT DAB)

Dulbecco's Modification of Eagle's Medium (DMEM)

DynaMag-2 

Ear punch

EDTA (0.5M, pH 8.0)

Endothelial Cell Growth Medium-2 (EGM2) Bulletkit (basal medium and supplements) 

Eosin Y (alcohol-based)

Ethanol 

Fetal Bovine Serum (FBS) , HyClone 

Filter tip 1,250 μL

Filter tip 20 μL

Filter tip 200 μL

Formalin buffered solution (10%) 

Hemacytometer (INCYTO; Disposable) 

Hematoxylin 

Human plasma fibronectin purified protein (1mg/mL) 

Hydrogen Peroxide solution (30% w/w) 

ImageJ Software

Isoflurane, USP

magnesium sulfate heptahydrate (MgSO4.7H2O) 

Table of Materials Click here to access/download;Table of Materials;Table of materials.xlsx

https://www.editorialmanager.com/jove/download.aspx?id=1206542&guid=3732f492-c590-4723-88cf-297071431220&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1206542&guid=3732f492-c590-4723-88cf-297071431220&scheme=1


Basement Membrane Matrix (Phenol Red-Free; LDEV-free) 

Microcentrifuge tube (1.5 mL) 

Microscope Slide Superfrost (75mm X 25mm)

Needles, 26G x 5/8 inch Sub-Q sterile needles

Normal horse serum 

Penicillin-Streptomycin-L-Glutamine (100X) 

Permanent mounting medium (VectaMount) 

Pestle Size C, Plain

Phosphate Buffered Saline (PBS)

Scale 

Serological pipettes (10 ml) 

Serological pipettes (5ml) 

Sodium carbonate (Na2CO3)

Streptavidin, Horseradish Peroxidase, Concentrate, for IHC

Syringe (60ml) 

SYRINGE FILTER (0.2 µM)

Syringes (1 mL with Luer Lock) 

Tissue culture-treated plate (100 X 20 mm) 

Tissue culture-treated plate (145X20 mm)

Tissue culture-treated plates (60 X 15) mm

Tris-base (Trizma base)  

Trypan Blue Solution (0.4 %) 

Trypsin EDTA, 1X (0.05% Trypsin/0.53mM EDTA) 

Tween-20

Wheaton bottle 

Xylenes



Company Catalog Number Comments/Description

Envigo 069(nu)/070(nu/+) Subcutaneous injection 

Vector Laboratories B-1065 Histological anlaysis 

Thermo Fisher 974106 Cell culture

BSA A7906-50MG Cell culture; Histological analysis 

Sigma C7902-500G Cell culture 

Electron Microscopy Sciences 50996491 Lesion plug measurment 

Life Technologies 11155D EC separation

Greiner 542000 Cell culture

Roche 10103578001 Cell culture

Greiner 07 000 241 Cell culture

Greiner 07 000 239 Cell culture

Ted Pella 21029 Histological anlaysis 

Fisher Scientific 12545E Histological anlaysis 

Vector Laboratories SK-4105 Histological anlaysis 

Corning 10-027-CV Cell culture

Life Technologies 12321D EC separation

VWR 10806-286 Subcutaneous injection 

Life Technologies 15575-020 Histological anlaysis 

Lonza CC-3162 Cell culture

Thermo Scientific 71211 Histological anlaysis 

Decon Labs 2716 Histological anlaysis 

GE Healthcare SH30910.03 Cell culture

MidSci AV1250-H Multiple steps

VWR 10017-064 Multiple steps

VWR 10017-068 Multiple steps

Sigma F04586 Lesion plug dissection 

SKC FILMS DHCN015 Cell culture

Vector Hematoxylin H-3401 Histological anlaysis 

Sigma FC010-10MG Cell culture

Sigma H1009 Histological anlaysis 

Analysis 

Akorn Animal Health 59399-106-01 Subcutaneous injection 

Sigma M1880-500G Cell culture 



Corning 356237 Subcutaneous injection 

VWR 87003-294 EC separation

Fisher Scientific 1255015-CS Histological anlaysis 

Becton Dickinson (BD) BD305115 Subcutaneous injection 

Vector Laboratories S-2000 Histological anlaysis 

Corning 30-009-CI Cell culture

Vector Laboratories H-5000 Histological anlaysis 

Thomas Scientific 3431F55 EC isolation 

Fisher Scientific BP3994 Cell culture

VWR 65500-202 Subcutaneous injection 

VWR 89130-898 Cell culture

VWR 89130-896 Cell culture

Sigma 223530 Cell culture

Vector Laboratories SA-5004 Cell culture 

BD Biosciences 309653 Cel culture

Corning 431219 Cell culture

Becton Dickinson (BD) BD-309628 Subcutaneous injection 

Greiner 664160 Cell culture

Greiner 639160 Cell culture

Eppendorf 30701119 Cell culture

Sigma T6066 Histological anlaysis 

Life Technologies 15250061 Cell culture

Corning 25-052-Cl Cell culture

Biorad 170-6531 Histological anlaysis 

VWR 16159-798 Cell culture

Fisher Scientific X3P-1GAL Histological anlaysis 



Editorial Comments: 
 
• Please take this opportunity to thoroughly proofread the manuscript to ensure that 
there are no spelling or grammatical errors. 
 
• Protocol Detail: Please note that your protocol will be used to generate the script for 
the video, and must contain everything that you would like shown in the video. Please 
add more specific details (e.g. button clicks for software actions, numerical values for 
settings, etc) to your protocol steps. There should be enough detail in each step to 
supplement the actions seen in the video so that viewers can easily replicate the protocol. 
Em? 
 
1) Since human tissues is used, please add a human research ethics statement at the start 
of your protocol. 
R: The statement was added at the beginning of the protocol (line 99-100)  
 
2) 1.1.1: what is the concentration of each it. 
R: The growth factors are sold as part of a commercially available kit. The concentration of 
the growth factors is not indicated. Even upon request, the manufacturer was not able to 
provide this information.  
 
3) 2.1.1: what kind of surgery is performed for VM acquisition? Please cite references. 
R: Venous malformations are commonly resected by debulking surgery. We edited the text 
accordingly and included references (Roh YN, 2012 Ann Vasc Surgery; Marler JJ, 2005 Clin 
Plast Surgery). 
 
• Discussion: JoVE articles are focused on the methods and the protocol, thus the 
discussion should be similarly focused. Please ensure that the discussion covers the 
following in detail and in paragraph form (3-6 paragraphs): 1) modifications and 
troubleshooting, 2) limitations of the technique, 3) significance with respect to existing 
methods, 4) future applications and 5) critical steps within the protocol. 
R: We revised accordingly. 
 
• Commercial Language: JoVE is unable to publish manuscripts containing commercial 
sounding language, including trademark or registered trademark symbols (TM/R) and 
the mention of company brand names before an instrument or reagent. Examples of 
commercial sounding language in your manuscript are Wheaton, Matrigel, 
1) Please use MS Word’s find function (Ctrl+F), to locate and replace all commercial 
sounding language in your manuscript with generic names that are not company-
specific. All commercial products should be sufficiently referenced in the table of 
materials/reagents. You may use the generic term followed by “(see table of materials)” 
to draw the readers’ attention to specific commercial names. 
R: Commercial sounding language such as “Wheaton” and “Matrigel” were removed from the 
manuscript and replaced with generic names.  
 
2) Please remove the registered trademark symbols TM/R from the table of 
reagents/materials. 
R: We removed trademark symbols/names. 
 
• If your figures and tables are original and not published previously or you have 
already obtained figure permissions, please ignore this comment. If you are re-using 
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figures from a previous publication, you must obtain explicit permission to re-use the 
figure from the previous publisher (this can be in the form of a letter from an editor or a 
link to the editorial policies that allows you to re-publish the figure). Please upload the 
text of the re-print permission (may be copied and pasted from an email/website) as a 
Word document to the Editorial Manager site in the "Supplemental files (as requested 
by JoVE)" section. Please also cite the figure appropriately in the figure legend, i.e. 
"This figure has been modified from [citation]." 
R: All of the presented figures have not been published before.   
 
 
Comments from Peer-Reviewers:  
 
Reviewer #1: 
Manuscript Summary: 
This manuscript details a murine xenograft model of venous malformations (VM) using 
human derived endothelial cells from patients harboring two of the most prominent mutations 
linked to VMs (TIE2 and PIK3CA hyper activating mutations). The authors present detailed 
methods on the isolation, purification, maintenance, and expansion of patient derived VM 
ECs for the purpose of transplanting and creating human derived VMs in 
immunocompromised mice. VMs are relatively understudied and have very few animal 
models for investigation; thus, this type of experimental analysis is valuable for VM research 
and potentially testing therapeutic measures. Overall, the methods were clearly explained and 
easy to follow. I think a few minor items could be addressed to make the procedures even 
more straightforward and helpful. 
 
Major Concerns: 
No major concerns. 
 
Minor Concerns: 
1. Line 133: Could the authors include what was used to adjust the PH of the buffer to 9. 
R: The PH of the coating buffer is adjusted with HCl 1M . This information is now included 
in the text. (Section 1.4.1)  
 
2. Line 166: It would be helpful if this sentence could be coordinated with the next  
step/section of the process, such as adding " (proceed to 3.2.1)" or something to that 
effect. 
R: We thank the reviewer for pointing this out. After the centrifugation step (in 2.1.8) a 
reference to subsequent step 2.3 was included for clarification.  
 
3. Line 188-189: Could the authors note how long it usually takes the cultures to grow to 
a confluency of 40-50%. 
R: It typically takes between 2 and 3 weeks for the cells to reach this confluency. The text has 
been edited to include this information (Section 2.3.5).  
 
4. Section 4, Lines 194-212: It would be nice if it could be noted whether multiple EC 
colonies from the same dish can be isolated or whether this is not recommended. 
R: It is recommended to pool multiple EC colonies. A clarification was added (Section 2.3.6) 
and a new image was added to Figure 2 (A) showing a typical EC colony.  
  
5. Line 242: Is one supposed to aspirate all of the solution with our disturbing the beads. 



If so, perhaps it could be written as: Gently aspirate all of the liquid, which contains the 
CD31 negative fraction of cells, without touching the beads. 
R: That is correct and was clarified in the manuscript (Section 3.2.6 and 3.2.7). 
 
6. Line 302-303: Add the volume that should be used to resuspend the cells. 
R: The cells are resuspended in 3 mL of medium. This information was added in this revised 
manuscript (Section 4.2.4)  
 
7. Line 309-310: It might be helpful to know approximately how many 50 ml conical 
tubes with pelleted cells can be obtained from a typical dish of ECs (145 mm dish or 
whatever size is used) sitel?  
R: A confluent 145 mm cell culture dish contains about 8-9 x 106 cells. This number of cells 
is sufficient for at least 3 xenograft injections. This information is now included in Section 
3.3.6.  
	
8. If so, this might be a good place to mention the use of two-sided injections in the same 
mouse with one side serving as a "internal" control. 
R: In the case of VM patient-derived cells we cannot include “healthy” control cells of the 
same donor. This is because so far we have not had success in isolating non-mutant ECs from 
VM tissue and cannot obtain healthy tissue from patients. Our group has used other primary 
non-mutant ECs such as HUVEC as internal control cells. These cells are forming 
significantly smaller and less vascular channels (Goines et al. 2018, Angiogenesis). The 
choice and possibility of internal controls is based on the experimental design of the study in 
which the model is used. If available; control cells (“healthy” or non-mutant control cells) 
could be included as internal control within the same animal. If planning to inject control 
cells, those cells will need to be expanded and prepared the same way as mutant EC.  
Additionally, for pre-clinical experiments, the second injection could serve as a technical 
duplicate of cells of the same patient within the same animal. 
A clarifying sentence was added to Section 4.2.5. and this point has been addressed in the 
discussion. 
 
9. Line 366-367: Harvesting of the xenograft doesn't mention whether to include the skin 
or not. However, the discussion talks about including the skin during harvesting for 
integrity purposes. This should be include in the procedure details as well. 
R: Thank you for pointing this out. This important detail was added to the procedures (Section 
5.2)  
 
10. Line 417: Could the authors include what was used to adjust the PH to 9. 
R: The pH of the Tris-EDTA buffer is adjusted with 1M HCl The information is now included 
(Section 8.1)  
 
11. Line 475: I am unfamiliar what the term "x-plane" means in this sentences. Could 
the authors clarify this description. 
R: The term x-plane describes the pattern in which the five images (High power fields) are 
taken within one lesion. For clarification an image was added (Figure 2F) visualizing this 
pattern (Step 9.2).  
 
12. Line 552-553: The use of cells for xenografts being within 2 to 5 passages is 
important and should be include in the procedures, not just the discussion. 



R: Thank you for pointing this out. This information is missing in the protocol section. The 
cells should be used between passage 3 and 8. This information was corrected in the 
discussion and also included in Step 3.3.6.  
 
13. Line 565-566: This mentions the number of animals and xenografts to be used in an 
experiment for statistical significance. I'm wondering how "internal controls" on the 
same mouse (one-she) fit into this or whether internal side controls on the same mouse 
are even used. 
R: The choice and possibility of internal controls is based on the experimental design of the 
study in which the model is used. If available; control cells (“healthy” or “non-mutant control 
cells”) could be included as internal control within the same animal. In pre-clinical or drug 
treatment studies, the second injection could serve as a technical duplicate of cells of the same 
patient within the same animal.  The model is in this case used for the analysis of vascular 
channels formed in treated vs untreated (vehicle-only) mice 
 
 
 
Reviewer #2:  
Manuscript Summary: 
This is an excellent article by Schrenk, Goines, and Boscolo that clearly describes the 
protocol to develop a xenograft mouse model of venous malformation. The authors have done 
a careful job at describing all the critical steps required to reproduce this experimental 
approach. The technique is of great interest in the field of angiogenesis and vascular 
anomalies and nicely complements the existence of other genetically engineered mouse 
models. I have made some comments to try to improve this already excellent protocol. 
 
Major Concerns: 
None 
 
Minor Concerns: 
- Could the authors include an approximate range of the size of the lesions used for the 
isolation? This seems to be an important detail, since the authors indicate that these cells 
can not be passaged indefinitely. Similarly, for the approach using blood from 
sclerotherapy, could the authors indicate the range of volumes that work well for this 
protocol? Also, what is the approximate number of cells that are isolated in this step? 
The authors indicate that they use 1 mL, but they don't mention the concentration of 
such cell suspension. 
R: The size/volume of samples varies greatly and depends on the patient’s status and severity 
of disease (how much tissue had to be excised). Furthermore, we only obtain a small portion 
of the resected tissue as most of it needs to be sent for pathological assessments. In general, 
tissue specimens we obtain range between 0.5g -1.5g. In our hands, the tissue processing 
always leads to a successful EC isolation no matter the initial size of tissue obtained. Lesional 
blood from sclerotherapy can be in the range of 0.5 mL and 5 mL. The isolation of ECs from 
lesional blood is not always successful but no correlation between sample volume and EC-
isolation success has been noticed.  
Regarding initial cell number, we do not perform cell counting. This is because the initial cell 
suspension is a mixture of different cell types including red blood cells present within the 
sample. Therefore the cell number is not suggestive of how many EC colonies will be 
growing. A large number of these initial cells will not attach and will be removed when the 
medium is changed.  



 
- Indicate the reason by which hydrocortisone is not added to the cell media. 
R: In our hands as well as reported by other groups (Kraling BM, 1998, In vitro Cell Dev 
Biol) the addition of hydrocortisone is not necessary for EC survival and proliferation. 
Furthermore, in previous publications hydrocortisone in the presence of heparin (also 
included in our medium) has been shown to inhibit angiogenesis (Folkman J, 1986, Cancer 
research). However, since hydrocortisone is part of the cell culture medium bullet kit that we 
use, we wanted to clarify that we are not using this component of the supplied supplements. 
 
- How many passages can these cells tolerate before cell injection?  
R: This is an important point. Cells should be used between passage 3 and passage 8. The 
information is now included in section 3.3.6.  
 
-Can these tumors be expanded once engrafted in the mouse as it has been done in PDX 
for tumors? 
R: We have not tried to expand lesions in a secondary host. However, this should be feasible 
based on Kang KT, 2011 Blood. 
 
- Please specify the nature of the pestle used. Is it a Douncer homogenizer? 
R: A teflon tissue homogenizer (6 mm, smooth-surface pestle grinder) that fits into a 50 mL 
conical tube was used in our studies. This information was included in section 2.1.5. 
 
- The authors comment that cells can be injected in the "hind legs". Yet, the figure 
seems to indicate the flank of the mouse. Please clarify; it seems intuitive that the cells 
would be injected in the flanks and the authors mean above the hind legs. . 
R: Yes, cells are injected in the flank and not hind legs – We edited the text accordingly.  
 
 
 
Reviewer #3:  
Manuscript Summary: 
The manuscript provides a detailed protocol for generating xenograft murine models of 
venous malformation, by injecting cultured endothelial cells that were isolated directly from 
patients' lesions. Overall, the steps provided could be reasonably followed and lead to the 
anticipated results. The VM mouse model would be an asset in understanding the endothelial 
functional defect of venous malformations (and possibly other vascular 
malformations/syndromes) and to test potential drug candidates for treatment. 
 
However, additional details could be included to clarify certain aspects of the protocol. Some 
specific points: 
 
1. Generally, approximate average time periods (e.g. 5-7 days) for the in vitro culture 
would help, particularly with the pre-CD31-Dynabead selection cultures. 
R: For the pre-CD31-Dynabead selection, it typically takes between 2-3 weeks for the EC 
colonies to appear and another 5-7 days for the colonies to grow to a size where those 
colonies start touching one another. At this point the EC colonies are ready to be harvested.  
For clarification average time periods have been added in section 2.3.5 and 2.3.6. 
 
2. Point 2.4.6 (line 208-09), where the plate size to use is dependent on the number of 
isolated EC cultures, is ambiguous. How many EC colonies could one expect overall? 
How many would be needed to decide to grow on the larger-sized plate? 



R: Approximately 3-5 EC colonies can be obtained from each sample. This information was 
added to the protocol (Step 2.3.6). A cell counting step was added (Step 2.4.6). The cell 
density in which the cells have to be plated  is 1x104 cells/cm2 . This important information 
was added to the manuscript in step 2.4.7.  
  
3. For point 3.2.1 (Line 231), how were the ECs detached and pelleted? Trypsinization, 
manual scraping, etc? 
R; The cells are detached by trypsinization. These missing steps are now included as 2.4.9 – 
2.4.11. A reference to these steps was added under 3.2.1.  
 
4. It seems like a step is missing from the Dynabead separation of the endothelial cells to 
the culturing (point 3.2.7-8, lines 246-50). There is no mention of if/how the CD31+ cells 
are detached from the beads. Are the beads still attached when the ECs are cultured? If 
so, would it act as a contaminant in the culture or seen in the plug? 
R: The beads are still attached to the cells when the cells are initially plated but then release 
during culture. A small number of beads might still be present within the first few passages of 
these cells. Sometimes, the beads can even be found within the xenograft plug. However they 
have been proven to be non-toxic and therefore do not interfere with subsequent analysis. The 
Information was added to under 3.2.11. 
 
5. The approach to analyze the human-derived vascular channels (section 9) is not clear. 
When the images are opened in ImageJ, what is meant to "stack" the images? Also, for 
point 9.8 (lines 491-92), what constitutes as the values for the "total area of the lesion" 
and "the total area of a single image" could be better defined. 
R: Thank you for pointing this out. The description of the vascular area quantification has 
been revised and is now described in greater detail. See step 9.2 -9.9  
 
 
Major Concerns: 
Firstly, there is discrepancy regarding identification of ECs in vitro. Point 2.3.6 (line 
191-2) mentions that the mixed cell culture should be "observed daily for appearance of 
EC colonies", then refers to Figure 2A as an example of the cobblestone-like appearance 
typical of EC colonies. However, Figure 2A is noted as a purified (assumingly post-
selection) EC culture in the figure legend. It would be more helpful to show an image of 
the true mixed cell culture so that one can visualize the various types of cells and ensure 
the correct colonies are chosen during the manual isolation step. 
R: That is a good observation. We added a new figure showing a mixed culture containing 
endothelial cells and non-endothelial cells before purification (Figure 2A). In the discussion 
we now refer to this image.  
 
Also, in the discussion, the authors mention that contaminating non-endothelial cells 
could still be present in isolated EC cultures, which are "easily recognized by elongated 
morphology" (Lines 546-47). However, it has been published that one of the pathological 
features of cultured ECs overexpressing TIE2 and PIK3CA is an elongated shape 
(Limaye, et al. AJHG 2015 and Natynki et al. HMG 2015); in Figure 2A, a few ECs 
appear to demonstrate this trait. Differentiation between a contaminating non-EC and a 
mutant EC would need to be clarified. 
R: That is correct. In respect to “normal” non-mutant endothelial cells, VM-derived ECs can 
show an elongated morphology as described in the above mentioned references. However, 
there are strong differences in mutant EC morphology and the morphology of contaminating 
fibroblasts. To clarify this, the new image in figure 2 (Figure 2A) shows an unpurified 



primary culture that allows clear identification of such contaminating fibroblasts (FB) in 
contrast to VM-ECs (EC).  
 
 
Secondly, a disclaimer was mentioned within the "REPRESENTATIVE RESULTS" 
that it's not recommended that xenograft lesions do not exceed 9 days due to increased 
murine infiltration that complicates analyses (Line 507-8). It would be good to elaborate 
what complications arise and possible strategies to overcome it (as in the discussion). It 
also raises questions on the ability for the model to be used for preclinical screening 
since many therapies would likely need a longer time period to evaluate effects. 
R: We would like to describe in better detail what we are referring to.  While in mutant-EC 
xenografts this is not a problem as all of the enlarged, malformed vessels are of human origin 
(as shown in Goines J et al., 2018,Angiogenesis), when injecting control cells such as 
HUVEC we have noted infiltration of host, murine-derived vascular channels into the plug. 
When comparing mutant-EC xenograft with control HUVEC xenograft, it is important to 
know these changes happen around/after day 9. Notably, this ‘problem’ could be overcomed 
by a staining for human-specific marker such as human-specific CD31 antibody or Ulex 
europaeus agglutinin I (UEA-I).  Finally, because in mutant-EC xenografts recruitment of 
murine EC is negligible and only present at periphery of the plug where anastomosis occurs, 
pre-clinical studies are possible and have been performed by our group for up to 6 weeks 
(Boscolo E., 2015 Journal of Clinical Investigation; Li X et al., 2019 Arterioscler Thromb 
Vasc Biol). A clarifying sentence was included in the result section.	 
 
 
Minor Concerns: 
The authors recommend that 2.5x106 cells per injection. Should there be insufficient 
numbers of cells grown, what would be the minimal number of cells that could be 
injected and still produced lesions within matrigel plugs? 
R: The number of cells of 2.5x106 cells per injection is necessary for a successful xenograft. If 
there are fewer cells available, it is recommended to reduce the number of injections/per 
animal. Alternatively, the injection-volume could be reduced to 100uL. In this case it is very 
important to keep the cell density equal (2.5x106  cells /200uL BMEM).   A paragraph was 
added to the revised discussion.  
 
 
Reviewer #4:  
Manuscript Summary: 
The authors present a well-written and detailed protocol on how to generate a murine 
xenograft model of venous malformation, based on the subcutaneous injection of patient-
derived endothelial cells containing hyper-activating TIE2 and/or PIK3CA gene mutations. 
Overall, the manuscript meets the Jove Journal standard and scope. However, by answering 
key questions along the text or providing some extra information, the protocol presented here 
could be improved 
 
Major Concerns: 
 
* Which control cells (non-mutant) are used for the xenograft model? What is the 
difference between the histology of the lesion formed from EC isolated from a human 
VM or control cells (non-mutant)? Without this comparison it is not easy to appreciate 
whether EC isolated from VMs reproduce the disease or it is simply a vessel growth 
assay. 



R: In the case of patient-derived cells we cannot include “healthy” control cells of the same 
donor. This is because so far we have not had success in isolating non-mutant ECs from VM 
tissue and cannot obtain healthy tissue from patients. We have used other primary non-mutant 
ECs such as HUVEC as a control and have shown that these cells are forming only a 
negligible number of small channels (Goines et al. 2018, Angiogenesis). A paragraph 
addressing this point was added to the discussion. 
 
* How do authors know that all EC carry the driver mutation? Is this culture 
heterogenous? 
R: This is a very good question: Isolated cells are routinely sequenced by Sanger-Sequencing 
as we have published recently (Goines et al. 2018, Angiogenesis). The cultures are 
heterogeneous in the sense that they arrive from a pool of several colonies and not from single 
cell clones.  Our attempts to purify mutant ECs from non-mutant EC by single cell-derived 
clonal expansion were not successful. For this reason, we hypothesized that non-mutant EC 
from the same patient have lower clonogenic and thus proliferative potential compared to 
mutant EC. Taken this together, we speculate that after few passages our cultures are mostly 
composed by mutant EC . 
 
 
* It would be good to include a picture of a non pure isolation (mixed of ECs and 
fibroblasts) for the reader to understand what none pure looks like. 
R: This is a good point. We added a figure showing a culture of mixed cells before EC 
purification (Figure 2A).  
 
Minor Concerns: 
* There are 3 groups which simultaneously discovered that venous malformations are 
cause by mutations in PIK3CA, this should be more clearly reflected in text (Limaye et 
al, and Castel et al, Castillo et al). 
R: Thank you for pointing this out. We included these references (3-5) and included a 
sentence to the introduction to specify that our protocol is also relative to TIE2 and PIK3CA 
mutations as our xenograft model can be performed with PIK3CA-mutated EC, as previously 
shown in Goines J et al., 2018, Angiogenesis. 
	


